MS Project Integration Guide

March 2014
## Contents

- **Introduction** ................................................................. 5
- **Document Conventions** .................................................. 5
- **Administration** .................................................................. 5
  - MS Project Template ...................................................... 6
  - MS Project Template Usage ............................................. 6
    - Project Metadata ......................................................... 6
    - Project WBS/Assignments .......................................... 6
- **Connection Mode** ............................................................ 7
  - Online Mode .................................................................... 7
  - Offline Mode .................................................................... 7
- **Locking Projects** ............................................................. 7
- **Mapping** .......................................................................... 8
- **Exporting Project Data** .................................................. 9
  - Installing the Plug-In ..................................................... 9
  - Exporting Project Data .................................................. 9
- **Importing Project Data-Direct Option** .............................. 10
- **Importing Project Data-File Option** .................................. 10
- **For More Information** ...................................................... 11
  - Where to Get Documentation ........................................ 11
  - Where to Get Training .................................................. 13
  - Where to Get Support ................................................... 13
- **Legal Notices** ................................................................... 15
Introduction

This document provides an overview of the MS Project integration for Oracle Instantis EnterpriseTrack. EnterpriseTrack MS Project Connector allows you to exchange project details between EnterpriseTrack and MS Project. The connector allows users to work offline and/or perform day-to-day project tracking using MS Project. Project managers can then periodically synchronize project information from MS Project with EnterpriseTrack. With this approach senior management and global teams access the central server environment with a browser, while project managers use their tool of choice (browser-based project tracking interface or MS Project desktop interface) to manage and track their projects.

**Note:** The primary focus of the integration is with MS Project 2007. There are minor differences in the integration capabilities provided by the Connector to MS Project 2007 and MS Project 2010.

Document Conventions

The following conventions are used in this manual to convey instructions and information:

The description of a menu item and its sub-items is described in this document as **(Page Menu) View > Toolbar > Display Print-Data Toolbar**, where you should click on the **View** Page Menu, then find the Toolbar sub-item and then click on the **Display Print-Data Toolbar** sub-item.

- Screen names and field names are in bold text.
- The actions you need to take on each screen are in bold text.

Administration

**In This Section**

MS Project Template............................................................................................................................................................................. 6
MS Project Template Usage........................................................................................................................................................................ 6
**MS Project Template**

You can upload the MS Project template and add it to a roadmap from the Administration section of the EnterpriseTrack system. Only System Administrators can manage the MS Project template and can enable or disable MS Project integration for specific roadmaps. The MS Project integration flag is displayed on the Project Roadmap page.

The template helps preserve the look and feel of the MS Project file as defined by the Administrator. New projects are created using the roadmap (activity template) setup in EnterpriseTrack and the MS Project template provided. The tasks in the MS Project Template are also imported.

To enable MS Project Import/Export and to select a template file:

1) Navigate to the Administration module.
2) Select Roadmaps. The Roadmap List page is displayed.
3) Select the [MS Project] link associated with the roadmap you want to edit.
4) Select Yes to enable MS Project Import/Export.
5) Click the Browse button and select an MS Project template file.
6) Click Update.

**MS Project Template Usage**

When a project is exported for the first time, if the project roadmap has an associated MS Project template, then the template is used to create a new MS Project file. If a template does not exist then the default MS Project template on the user’s desktop is used to create the MS Project file. You can then make changes in MS Project and export to EnterpriseTrack. Along with task information, the MS Project file will also be uploaded to the server. When you export project information from EnterpriseTrack, the uploaded file at the project level (not admin level) will be used. This retains the look and feel of the MS Project file saved by the last Project Manager.

**In This Section**

Project Metadata ................................................................. 6
Project WBS/Assignments ..................................................... 6

**Project Metadata**

When a project is exported from EnterpriseTrack to MS Project, most of the information embedded in the uploaded MS Project file (or template) is retained. Project information such as custom fields, visible columns, column size/order, and embedded macros from the attached MS Project template are carried forward. The project calendar used in EnterpriseTrack is passed on to the calendar in MS Project. Milestone activities are also synced properly with MS Project milestone tasks.

**Project WBS/Assignments**

When a project is exported from EnterpriseTrack to MS Project, task, resources and task-assignments from EnterpriseTrack are used to populate the MS Project file.
Connection Mode

In This Section

Online Mode ........................................................................................................................................... 7
Offline Mode ........................................................................................................................................... 7

Online Mode

When you are online you can import/export project data from EnterpriseTrack/MS Project using the ET-XML interface file. Using the import/export options in the EnterpriseTrack UI, you can save the ET-XML file to your desktop or open it directly. MS Project is launched automatically and the contents of the file are processed to create the MS Project file.

Offline Mode

While online, you can export a project from EnterpriseTrack and save it to your desktop. If you go offline, you can still use the saved ET-XML file, import it into MS Project and make changes as required. When you are online, you can then export the content from MS Project to EnterpriseTrack.

Locking Projects

When a project is locked, no direct changes can be made to the project. For example, project team members cannot update their status or finance analysts cannot update project budget, etc. Project Managers can lock an active project if they do not want any changes to be made to the project. You can also lock projects that are complete to prevent further updates from being made. The project lock status is displayed on the project Import/Export page. If a project is On-Hold, you can only perform a Read-Only Export.

You can perform limited editing on the following items when the project is locked.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Locked</th>
<th>Allowed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roadmap</td>
<td>All sections are read-only.</td>
<td></td>
</tr>
<tr>
<td>Dates</td>
<td>All sections are read-only.</td>
<td></td>
</tr>
<tr>
<td>Team—Resources</td>
<td>Most sections are locked.</td>
<td>You can add new team members.</td>
</tr>
</tbody>
</table>
You cannot release an allocation slot as it can result in deleting a team member.

You can edit the other sections.

Settings page is locked.

You can edit the other sections.

Approvals that can result in deletions of team members.

You can edit the other sections.

The documents that are referenced in the activities are locked.

All other documents can be edited.

The following items are editable when a project is locked:

- Timesheets
- Metrics
- Notes
- Strategy
- Survey
- Issues
- Status Reports
- Non-WBS Items

**Mapping**

This section describes the mapping of data fields that take place during MS Project integration.

- Task Type in MS Project maps to Scheduling Mode in EnterpriseTrack.
- EnterpriseTrack to MS Project Mapping

<table>
<thead>
<tr>
<th>EnterpriseTrack Planned Effort Type</th>
<th>MS Project Task type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration &amp; Resource % Availability</td>
<td>Fixed Duration--non-effort driven</td>
</tr>
<tr>
<td>Effort at Activity Level -- Equal % Distribution</td>
<td>Fixed Work</td>
</tr>
<tr>
<td>Effort at activity Level -- Unequal % Distribution</td>
<td>Fixed Work</td>
</tr>
<tr>
<td>Effort at Resource Level: Summary</td>
<td>Fixed Work</td>
</tr>
<tr>
<td>Effort at Resource Level: Detailed</td>
<td>Fixed Work</td>
</tr>
</tbody>
</table>

- MS project to EnterpriseTrack Mapping
Exporting Project Data

EnterpriseTrack allows you to export project data to and from MS Project. This functionality allows you to update your project data in MS Project. A series of steps have to be completed in sequence before you can export the project data. Before you begin exporting project data, do the following:

- Ensure that you have an MS Project template. This template is used when you export/import data from EnterpriseTrack. If no template is added, the default MS Project template is used.

In This Section

Installing the Plug-In ................................................................. 9
Exporting Project Data ................................................................. 9

Installing the Plug-In

To install the EnterpriseTrack plug-in for MS Project:

**Note:** This procedure needs to be done only once per client machine.

1) Navigate to the project Import/Export page by clicking the Import/Export link within a particular project.
2) Click the Show button next to Downloads.
3) Select the Download EnterpriseTrack Plug-in for Microsoft MS Project Connector link and save the file to your local drive.
4) Close all MS Project widows. Run the .exe file. This will install the plug-in on your machine. When you launch MS Project, you will see an Oracle Instantis EnterpriseTrack submenu under the Tools menu.

Exporting Project Data

To export project data:

<table>
<thead>
<tr>
<th>MS Project Task Type</th>
<th>EnterpriseTrack planned Effort Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Duration -- non-effort driven</td>
<td>Duration &amp; Resource % Availability</td>
</tr>
<tr>
<td>Fixed duration -- effort driven</td>
<td>Duration &amp; Resource % Availability</td>
</tr>
<tr>
<td>Fixed units -- non-effort driven</td>
<td>Duration &amp; Resource % Availability</td>
</tr>
<tr>
<td>Fixed units -- effort driven</td>
<td>Effort at Resource Level (Summary)</td>
</tr>
<tr>
<td>Fixed Work</td>
<td>Effort at Resource Level (Summary)</td>
</tr>
</tbody>
</table>
1) Navigate to the project Import/Export page by clicking the Import/Export link within a particular project.
2) Click the Export Project data to Microsoft Project link.
3) Select the type of export you want to perform: Read-Only Export or Lock Project and Export. Read-Only Export allows you to export the project to MS Project without having to import it back into EnterpriseTrack. If you lock a project, no changes can be made to the project. You can make changes only when the lock is released. The project lock status is displayed on the Project Import/Export page. If a project is On-Hold, you can only perform a Read-Only Export.
4) Click the Read-Only Export button or the Lock Project and Export button.
5) You can open the exported file or save it to disk. When you open the file, MS Project is launched and the exported project file is opened.
6) In MS Project, you can make changes to the project.

**Importing Project Data-Direct Option**

Before you begin importing data directly into EnterterpriseTrack from MS Project, do the following:

- Ensure that you have a MS Project template. This template is used when you export/import data from EnterpriseTrack.
- Check if you have downloaded the latest version of the Oracle Instantis EnterpriseTrack plug-in for MS project.

To import project data using the direct option:

1) Launch MS Project on your machine.
2) In MS Project, from the Tools menu select Oracle Instantis EnterpriseTrack > Export > To EnterpriseTrack. The Oracle Instantis EnterpriseTrack Login screen displays.
3) Enter your login ID and password.
4) Check the Release Project Lock box to release the project lock and import.
5) Select the composition mode. By default, External read-only is selected. In this mode, the MS Project dates and costs are used.
6) Click OK. You will see a pop-up screen confirming that the data was successfully exported.

**Importing Project Data-File Option**

You can use the Import feature when you are ready to bring all your data into EnterpriseTrack. Before you begin importing data, do the following:

- Ensure that you have an MS Project template. This template is used when you export/import data from EnterpriseTrack.
- Check if you have downloaded the latest version of the Oracle Instantis plug-in for MS Project.
To import data using the file option:

1) Launch Microsoft Office Project on your machine
2) In MS Project, from the Tools menu select Oracle Instantis EnterpriseTrack > Export >To EnterpriseTrack via File. The plug-in saves the required data as a zipped XML file.
3) Save the file to a directory.
4) From EnterpriseTrack, navigate to the project Import/Export page by clicking the Import/Export link within a particular project.
5) Click the Import Project data From Microsoft Project link.
6) Check the Release Project Lock box to release the project lock and import. Leave the box unchecked if you do not want remove the lock.
7) Click Browse. Locate the file that you saved in Step 3.
8) Click Import to begin the import process. A confirmation message is displayed when the data is successfully imported. Your data can now be viewed within EnterpriseTrack.

For More Information

In This Section

Where to Get Documentation ................................................................. 11
Where to Get Training ........................................................................ 13
Where to Get Support ......................................................................... 13

Where to Get Documentation

For the most up-to-date versions of all manuals and technical documents related to installing, administering, and using EnterpriseTrack, go to:
http://docs.oracle.com/cd/E50622_01/index.htm

You can also access the versions of the product manuals and technical documents that were available at the time of the release from the Documentation Library, click index.htm in the Documentation folder of the physical media or download.

Most documentation assumes a standard setup of the product, with full access rights to all features and functions.

The following table describes the core documents available for EnterpriseTrack and lists the recommended readers by role.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EnterpriseTrack User Help</td>
<td>Describes how to work with EnterpriseTrack and provides information to assist users with using EnterpriseTrack features.</td>
</tr>
<tr>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>All users should read this Help.</td>
<td></td>
</tr>
<tr>
<td><strong>EnterpriseTrack Administrator’s Help</strong></td>
<td>Describes how to work with EnterpriseTrack Administrator’s console to manage your deployment and change various aspects of the application. EnterpriseTrack administrator should read this Help.</td>
</tr>
<tr>
<td><strong>EnterpriseTrack User Guide</strong></td>
<td>Guides users on how to use the EnterpriseTrack application. All users should read this guide.</td>
</tr>
<tr>
<td><strong>EnterpriseTrack Administrator’s Guide</strong></td>
<td>Provides detailed information on using the EnterpriseTrack Administrator’s console. EnterpriseTrack administrator should read this guide.</td>
</tr>
<tr>
<td><strong>EnterpriseTrack Dashboard and Reports Guide</strong></td>
<td>Provides detailed instruction on using the EnterpriseTrack Dashboards and Reports modules to generate dashboards, standard reports, ad-hoc reports and user-defined reports. All users should read this guide.</td>
</tr>
<tr>
<td><strong>EnterpriseTrack Quick Reference Guide</strong></td>
<td>Provides a quick introduction to common EnterpriseTrack tasks. All users should read this guide.</td>
</tr>
<tr>
<td><strong>EnterpriseTrack Installation Guide</strong></td>
<td>Provides information on how to install and configure EnterpriseTrack. EnterpriseTrack administrator, network administrator and database administrator should read this guide.</td>
</tr>
<tr>
<td><strong>EnterpriseTrack MSP Integration Guide</strong></td>
<td>Provides an overview of MS Project integration for EnterpriseTrack. EnterpriseTrack users who will perform MS Project integration should read this guide.</td>
</tr>
<tr>
<td><strong>EnterpriseTrack API Integration Guide</strong></td>
<td>Provides information that allows customers to customize an existing third-party integration. Developers interested in customization and existing third-party providers that integrate with EnterpriseTrack should read this book.</td>
</tr>
<tr>
<td><strong>EnterpriseTrack Upgrade Guide</strong></td>
<td>Provides a sequence of procedures that must be completed to upgrade to a new version of EnterpriseTrack. EnterpriseTrack administrator and database administrator should read this guide.</td>
</tr>
<tr>
<td><strong>EnterpriseTrack Tested Configurations</strong></td>
<td>Lists the configurations that have been tested and verified to work with EnterpriseTrack. EnterpriseTrack administrator, network administrator, and database administrator should read this guide.</td>
</tr>
</tbody>
</table>
For More Information

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EnterpriseTrack Cumulative Features Overview Tool</td>
<td>Provides an overview of features and enhancements included in the Oracle EnterpriseTrack product. It is intended solely to help you assess the business benefits of upgrading. All users should read this guide.</td>
</tr>
<tr>
<td>EnterpriseTrack Security Guide</td>
<td>Provides guidelines on how to plan your security strategy for EnterpriseTrack. All users, EnterpriseTrack administrators, network administrators and database administrators should read this guide.</td>
</tr>
</tbody>
</table>

**Distributing Information to the Team**

You can copy the online documentation to a network drive for access by project participants. Each team member can then view or print those portions that specifically relate to his or her role in the organization.

Throughout this documentation, the Security Guidance icon 😸 helps you to quickly identify security-related content to consider during the installation and configuration process.

**Where to Get Training**

To access comprehensive training for all Primavera products, go to:

http://education.oracle.com

**Oracle Learning Library**

The Oracle Learning Library (OLL) provides online learning content covering Primavera products. Content includes videos, tutorials, articles, demos, step-by-step instructions to accomplish specific tasks, and self-paced interactive learning modules.

To access the learning library’s Primavera content, go to:

http://www.oracle.com/goto/oll

**Where to Get Support**

**Access to Oracle Support**

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/us/support/contact-068555.html or visit http://www.oracle.com/us/corporate/accessibility/support/index.html if you are hearing impaired.
Using Primavera's Support Resource Centers

Primavera’s Support Resource Center provides links to important support and product information. Primavera’s Product Information Centers (PICs) organize documents found on My Oracle Support (MOS), providing quick access to product and version specific information such as important knowledge documents, Release Value Propositions, and Oracle University training. PICs also offer documentation on Lifetime Management, from planning to installs, upgrades, and maintenance.

Visit https://support.oracle.com/epmos/faces/DocumentDisplay?id=1486951.1 to access links to all of the current PICs.

PICs also provide access to:

- **Communities** are moderated by Oracle providing a place for collaboration among industry peers to share best practices.
- **News** from our development and strategy groups.
- **Education** contains a list of available Primavera product trainings through Oracle University. The Oracle Advisor Webcast program brings interactive expertise straight to the desktop using Oracle Web Conferencing technology. This capability brings you and Oracle experts together to access information about support services, products, technologies, best practices, and more.

For more information about working with Support, visit https://support.oracle.com/epmos/faces/DocumentDisplay?id=888813.2.
Legal Notices

Oracle Instantis EnterpriseTrack MS Project Integration Guide

Copyright © 2000, 2014, Oracle and/or its affiliates. All rights reserved. Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are "commercial computer software" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate failsafe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

This software or hardware and documentation may provide access to or information on content, products and services from third-parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.